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Chapter 1 Quick start of easySCADA

This chapter introduces installation of easySCADA configuration software, including
installation of configuration program and DATABASE SOFTWAER, as well as basic functions
and main characteristics of the software. It also introduces in detail the composition of the
software system and the functions of each object, helping users to understand the overall
structure framework of easySCADA configuration software. In addition, it introduces the
hardware and software requirements of easySCADA, and the installation process and working
environment of easySCADA, helping users to learn use of this software and create application
projects.

1.1 Functions and features of easySCADA are as follows:

1. Complete functions. easySCADA has complete functions, including basic shape drawing,
coloring, text preparation, system picture library, animated display, bitmap status change,
trend picture display, alarm control powerful functions such as dynamic circle, dynamic
rectangle, meter, historical data collection. Designers can easily design schemes and
configuration basing on their own requirements and characteristics of projects, and can
achieve satisfactory effects.
3. Communication. easyMonitor provides drives for communication with PLCs projects of all
ELC and EXM series CPU via RS232, RS485,Ethernet/GPRS. Available protocol is MODBUS
RTU/TCP.
4. Resources. easyMonitor provides abundant resources. The picture library of easymonitor
includes 3D indicator light, 3D button, television, 3D tank, 3D pipe, electron, bars, and the
like. In addition, many pictures are provided with animation properties and can be used to
design vivid animation. It also allows for user-defined picture library and inserting pictures
from Windows. easyMonitor also provides controls that have abundant functions, such as
trend diagram and alarming controls and the like, meeting the requirements of various
configurations.

1.2 Requirements of easySCADA for computer
1.2.1 Software requirements of easySCADA for computer
easySCADA configuration software can be run in the following operating systems:
� Microsoft Windows NT Server 4.0 or later release;
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� Microsoft Windows NT Workstation 4.0 or later release;
� Microsoft Windows 98, Me, 2000, XP or later release.
� Microsoft Windows 7, windows 8.

: easySCADA will refuse to be installed if the operating system does not meet the above
requirements.

1.2.2 Hardware requirements of easySCADA for computer
The minimum hardware requirements of easySCADA are:
� CPU: Pentium 3-800MHz as a minimum;
� Memory: When Windows 98 operating system is used, the memory should be 128MB or
above;
When Windows NT operating system is used, the memory should be 256MB or above;
When Windows 2000 or XP ,windows7, windows 8 operating system is used, the memory
should be 256MB or above;
Graphics card: Compatibility with Windows system, graphics memory of 1MB or above,
allowing for running at 1024*768, 256 colors.
� Hard disk: The minimum hard disk occupation of easySCADA configuration software is
200MB.
� Two-key mouse and keyboard.

: If the computer configuration is lower than the above requirements, easySCADA is likely
unable to be installed and operated.

Recommended configuration:
� CPU: Intel Pentium 800 or above, or equivalents;
� Memory: When Windows 98 operating system is used, the memory should be 256MB or
above;
When Windows NT operating system is used, the memory should be 512MB or above;
When Windows 2000 or XP operating system is used, the memory should be 512MB or above;
� Graphics card: Compatibility with Windows system, graphics memory of 1MB or above,
allowing for running at 1024*768, 65535 colors.
� Hard disk: Over 200MB.
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1.3 Installation of easySCADA configuration software
First part, you need install the “MySQL”.

1.Double click

to startup the installation. But if your OS is win7/win8, you

must start the installation as follows:

2. After starting up the installation program, the following language selection box will pop up,
allowing user to select English installation. click “OK”, then the startup dialog will pop up in
several seconds.

3. In the startup dialog, click Next to continue installation, or click Cancel to quit installation.
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4.In the license agreement dialog, please select whether to accept the software clauses, and
click “next”

5.Users can fill in their own personal or company information, or choose the default setting
“C:\MySQL6”, and then click “next”.
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6. After clicking “Next” in the dialog as shown in below Figure, a dialog will appear to allow
you to choose the installation folder. You may choose the default folder or other folders. Then,
click Next, as shown in below Figure.

7.
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8.

9.
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10.

11.Then install MySQL connector/ODBC.
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12.
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13.

14.
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15.

Part Two: Install “easyScada”

1. Double click

to startup the installation

2. After starting up the installation program, the following language selection box will pop up,
allowing user to select English installation. click “OK”, then the startup dialog will pop up in
several seconds.

3. In the startup dialog, click Next to continue installation, or click Cancel to quit installation.

13

.
4. In the license agreement dialog, please select whether to accept the software clauses, and
click “next”

5.Users can fill in their own personal or company information, or choose the default setting
“C:\Program Files\EASY\easyScada”, and then click “next”.
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6. After clicking “Next” in the dialog as shown in below figure, a dialog will appear to allow you
to choose the installation folder. You may choose the default folder or other folders. Then,
click Next, as shown in below Figure.
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7.

8.
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9.

10.

17

After that, an icon of “easyMonitor” will appear on the desktop
You can also click “easyMonitor” in “Start”---“All programs”--- “easyScada” to run
easyMonitor configuration software.

1.4 Operation of easyMonitor
After installation of SKWorkshop, a shortcut will appear on the desktop, as shown in Figure
2-17:

Figure 2-17: Shortcut on the desktop
Meanwhile, easyMonitor program group is added in Start menu of Windows, as shown in
Figure 2-18:
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Figure 2-18: Program icon in Start menu

Double click the shortcut on the desktop, or click easyMonitor in the easyScada program
group in the Start menu to run the software. See Figure 2-19 for the software running page:
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Figure 2-19: Software running page

1.5 Editing windows and creating communication connections

easyMonitor configuration software is the configuration visual development system of
easySCADA. As an integrated development environment software it has abundant and
powerful development functions. easyMonitor adopts the advantages of Windows system,
with high user interface consistency and simple interfaces. The layout of the menus is close
to those of Windows system, making it easy to learn, so that project designers can easily
develop suitable configurations for their projects using easyMonitor. The development
interface and the functional areas are shown in Figure 2-26.
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Figure 2-26: Interface and areas of the software


Menu bar: Displaying command menus of easyMonitor. All these menus are drop-down
menu.



Tool buttons: Shortcut buttons of some commands. Displaying corresponding buttons of
file, edit, drawing, and some other functions.



Picture area window: A window for designers to configure and edit graphs.



Project manager: Tree menu for window management, device selection,communication
connection parameter setting, kinds of register(IO, Analog IO..) selection.



Information output window: Displaying prompt messages such as input/output
information and error prompt when the designer are editing and compiling configuration.



Status bar: Displaying current configuration status, including coordinate of mouse,
control type, coordinate of control, size of control, and the like.

1.6 Menu bar of easyMonitor

Menu bar of easyMonitor configuration editing software provides users with abundant menu
options, and here you can find almost all tool commands and editing commands required
during configuration. The menu bar consists of File menu, Edit menu, Variables menu,
Drawlib(L)menu, Layout menu, Database menu,View menu, Help menu.And also includes
right click Menus. See Figure 2-27.
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Figure 2-27
1.6.1 File menu
File menu includes such options as New (Ctrl+N), Open (Ctrl+O), Close, Save(Ctrl+S), Save
As, Print..(Ctrl+P), Print Preview, Print Setup..., User manage and Exit. See Figure 2-28.

New : Used to create a new blank project. The shortcut key is Ctrl + N.
Open :Used to open an existing project file saved in Windows. Project configuration files with
an extension name of “.ezpj” can be opened. The shortcut key is Ctrl + O.
Close: Used to close the current project screen configuration without quitting easyMonitor
configuration software.
Save: Used to save the current screen configuration that has been changed, with the file
name and directory being the same as the original. The shortcut key is Ctrl + S.
Save As: Used to save the current screen configuration, with the file name and directory
being changeable.
Print: Print the widows
Print Preview: Print preview all the windows.
Print Setup: Print setup menu.
User manage: User manage option, user name and password can be set or modified here.
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Properties.. : You can choose the start view and set the time of the database save period.
Please note that the database save period is 1 Minute

Compile.. This menu is used to generate a project package for the end-user.
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Click “Compile”..
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One setup file will be created on your desktop, you can install it on your PC or other PC by
double click.
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You need register first, then the interface will be available.
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The can get the register code with the run the “Register” program in the easyScada folder.

Input the User machine code.(This code is from the PC which need install the monitor
software), then click “Get” button, the user register code will be generated. The you need tell
this register code to the end-users.

Input “register code” and click the “Register” button.
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Then the monitoring interface will be available.

1.6.2 Edit menu
“Edit” menu consists of commands used to edit screen, text and drawing as well as some
auxiliary commands, including Undo, Redo, Cut, Copy, Paste , Delete, Select All, Properties...
Undo: Used to cancel the last operation. The shortcut key is Ctrl + Z.
Redo: Used to recover the last operation. The shortcut key is Ctrl + Shift + Z.
Cut: used to delete the object chosen and copy it to the paste buffer area. The shortcut key
is Ctrl + X.
Copy: Used to copy the object chosen to the paste buffer area. The shortcut key is Ctrl + C.
Paste: Used to copy the object in the paste buffer area to the current screen. The shortcut
key is Ctrl + V.
Delete: Used to delete a chosen object. The shortcut key is Ctrl + Del.
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Select All: Used to select all the objects in the current screen of the current project. The
shortcut key is Ctrl + A.
Properties: to open the property dialog box of the object.
Set background color for window: to set the current window background color.
Set grid color for window: to set the grid color of current window.
Set grid size for window: to set the grid size of current window.

1.6.3 Variables menu

All the variables can be managed int such menu.
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Batch add: All the variables can be added with one button click.
Add: One variable will be added with one button click.
Delete: Delete the selected variable.
Clear: delete all the listed variable
Alarm/Event Settings
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1.6.4 Drawlib(L) menu

Add drawlib: To create a window library.
Delete drawlib : To delete the existed window library.
Add lib element: Add the combined objects into the named draw library.
Delete lib element: To delete the existed objects from the draw library.
Usage example.
1. Select some objects in the window and click right mouse, then combine.
2. Click the menu Add drawlib and to input a new name. Click ok.

Click the “show/hide drawlib” button

and select the

library named with “indicators”.

Then you can click “Add lib element”to add the combined objects into the library.
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Now you can use the combined objects in the library to put into the screen by double clicking
the left mouse. The menu “delete lib element” can be used to delete the objects in the library

1.6.5 Layout menu

Left align: used to align the left boundaries of the chosen objects on the left.
Right align: used to align the right boundaries of the chosen objects on the right.
Top align: used to align the top boundaries of the chosen objects at the top.
Bottom align: used to align the bottom boundaries of the chosen objects at the bottom.
Make same size: used to set the same height and width for the graphs chosen.The minimum
left coordinate is taken as the baseline.
Up:used to move the chosen object one layer forward.
Down:used to move the chosen object one layer backward.
To front:used to align the top boundaries of the chosen objects at the top.
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To bottom:used to align the bottom boundaries of the chosen objects at the bottom.
Show grid: To show the grid...
Snap to grid: Make the objects to snap to grid.
Show margin: To show the margin.
Snap to margin: Make the objects to snap to margin.
1.6.6 Database

You can select one or several variables and to export the data with .csv format.
1.6.7 View menu
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Toolbar: Hide or show the Toolbar.
Status Bar: Hide or show the status bar.
Workspace: Hide or show the workspace.
Info Window: Hide or show the Info Window.

1.6.8 Help menu

Help: Version number and copyright statement of easyMonitor are shown in Figure 2-37.

Figure 2-37
1.7 easyMonitor Toolbar

easyMonitor totally provides three lines of shortcut tool buttons, including tool commands
and editing commands. After getting familiar with these buttons, designers can find the
desired commands quickly without searching in the menu bar. Each button has a floating
prompt, which appears when you move the mouse to the button. easyMonitor totally provides
below tool buttons. When these buttons are grey, they are invalid under current operation
status. See Figure 2-39.

Figure 2-39: Tool bar

As shown in the figure above, the commands in the tool bar are corresponding to the
commands in the menus. The functions of the buttons are as follows:
Standard toolbar:
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:Corresponding to “New” command, with the shortcut key of Ctrl + N, used to create a
new blank project.
:Corresponding to “Open” command, with the shortcut key of Ctrl + O, used to open an
existing project file saved in Windows with an extension name of “.ezpj”.
:Corresponding to “Save” command, with the shortcut key of Ctrl + S, used to save the
current screen configuration that has been changed, with the file name and directory being
the same as the original.
: Used to delete the object chosen and copy it to the paste buffer area. The shortcut key
is Ctrl + X.
:Used to copy the object chosen to the paste buffer area. The shortcut key is Ctrl + C.
:Paste,Used to copy the object in the paste buffer area to the current screen. The shortcut
key is Ctrl + V.
: Undo
: Redo
:Print button
: Start monitor button
: Corresponding to “Zoom in” command, used to zoom in the current screen by 1x. For
further zoom in, click this button again.
: Corresponding to “Zoom out” command, used to zoom out the current screen by 1x. For
further zoom out, click this button again.

:To make the selected objects to snap to the margin.
: To show or hide the margin.
: To make the selected objects to snap to the grids.
:To show or hide the grids.
: To make multiple draw, that means if such button was clicked down, you can put the a
lot of times of the same one object into the window with one clicking on a certain object.
Otherwise you can only put one object with one clicking on a certain object.
:Corresponding to “Left align” command, used to align the left boundaries of the chosen
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objects on the left.

:Corresponding to “Right align” command, used to align the right boundaries of the
chosen objects on the right.

:Corresponding to “Top align” command, used to align the top boundaries of the chosen
objects at the top.

: Corresponding to “Bottom align” command, used to align the bottom boundaries of the
chosen objects at the bottom.

: Scroll arrow, used to change the palm shape under Translate command back to ordinary
mouse shape.
: To show or hide the draw library.

Draw toolbar:
Basic:

：Corresponding to “Line” command, used to draw a horizontal or vertical straight line.
：Corresponding to “Line” command, used to draw a straight line of any direction in the
current screen.

： Broken line, used to draw any shapes.
：Corresponding to “Curve/Arc” command, used to draw a curve or arc in the current
screen.

：Polygon, used to draw a polygon in the current screen.
：Corresponding to “Rectangle” command, used to draw a rectangle of any size in the
current screen. Also can be used to display Static text, or used to display the register value.
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：Round Rect, used to draw a round rectangle

of any size in he current screen.

：Corresponding to “Rounded rectangle” command, used to draw a rounded rectangle in
the current screen.
：Cylinder, used to draw a cylinder in the current screen.
：Sector command, used to draw a sector in the current screen.
：Trapezia, used to draw a trapezia in the current screen.
：Arrow, used to draw an arrow in the current screen.
：Multi text, used to display the static text, or display the register value in a fixed format.

： Data input, used to set register value(AF,AQ,REG), also can be used to display the
datas.
: Data display
: Clock display

: History data table

Bitmap

：Table, used to draw a table.
：Bitmap, used to be inserted into the bitmap file for displaying.
：Rotate bitmap, used to be inserted in to the bitmap which can be controlled.
：Gif file’ used to create an animation control in the current screen to move the controls.

：3D circle, used to display the digital IO, flag status
：Corresponding to “Bit button” command, used to set in the current screen a touch key
for bit operation of the connected device, including bit setting, resetting, inching and
alternation.

：Group box, used to draw group box.
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Curve

:Trend chart, used to create a trend chart control in the current screen to monitor the
value change trend of continuous addresses of the connected equipment.

:History trend chart, not available now.
:Data group display, used to create a data group display control in the current screen to
display several groups of data in the trend chart.
:Bar graph, used to insert a bar control in the current screen to show the change in the
values of the monitored address with height change or left-right movement of bars.
Meter

: Corresponding to “Meter” command, used to create in the current screen a meter to
monitor the change in the value of single address of the connected device.
:Meter2, to create in the current screen a meter to monitor the change in the value of
signal address of the connected device.
: Breaker shape
: Switch shape
: Transfer shape
: Fan shape
: button switch, used to set the digital flag and the output status.
: Pump shape
: Slider shape
: Progress shape, used to display the variable value.
: Flow shape
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Pipe

: Pipe, used to draw pipe shape.
: Connect pipe, used to draw connect pipe shape.
: Bend pipe, used to draw the bend pipe shape.
: Free pipe, used to draw the free pipe shape.
: Tank, used to draw tank shape.
:Elbow, used to draw elbow shape.
: Rod, used to draw rod shape.
: Rect pipe, used to draw Rect pipe shape.
: Free trapezoid, used to draw free trapezoid shape.
: standard trapezoid, used to draw standard trapezoid shape.
: Ellipse pipe, used to draw ellipse pipe shape.

Chapter 2 System composition of easyMonitor
2.1 Connection structure
easyMonitor is the configuration editing software of

esay SCADA. easyMonitor allows

designers to edit project configuration on PC and then directly start the monitor button. Then,
communication with PLC can be constructed through the serial cable or Ethernet/GPRS
connection. There are 3 ways can be applied to establish the connection between easyMonitor
and the Devices.( ELC/EXM series CPU)
1.Communication by RS232/RS485 mode between PLC and easyMonitor, the sever software
is not required.
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2. Communication by Ethernet mode between PLC and easyMonitor and the PLC works as
server, the server software also is not required.

3. Communication by Ethernet/GPRS mode between easyMonitor and the PLC works as client,
the server software would be required.
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EasyMonitor interface showing as above

EasyServer interface showing as above
2.2 Basic operations of easyMonitor
This chapter introduces operation of easyMonitor configuration software, including use of
mouse, shortcut keys and some terms.
2.2.1 Use of mouse and shortcut key of easyMonitor
When preparing configuration screens using mouse, the mouse is
as shown in Figure 2-41.
Now we introduce common mouse operations and the functions of
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such operations in the software:
◎ Left click
The process of pressing down the left key and then releasing is
called “Left click” in this Manual. It can be used to select

Figure 2-41

menu items, select object, select tool button, edit configuration
and confirm setting.
◎ Double click
The process of quickly and continuously clicking the left key twice is called “Double click” in
this Manual. It can be used to set properties for placed objects, set properties of screen and
window, After such clicking a dialog will appear for operation.
◎ Right click
The process of pressing down the right key of mouse and then releasing is called “Right click”
in this Manual. You can open a right click drop-down menu by right clicking an object, or open
a right click menu by right clicking a blank space.
◎ Drag
The process of moving the mouse while pressing the left key is called “Drag” in this Manual.
It can be used to select several objects, move objects, or move pop-up editing windows.

2.2.2 Mouse shape
When using easyMonitor software, the shape of the mouse may change with the operation to
distinguish different operation types and provide convenience for users. Table 2-1 below
shows the allowable operations of different mouse shapes.
Choosing object, and left clicking tool button.
1.Pasting.
2.Drawing a graph.
Inputting text.
Enlarging object vertically.
Enlarging object horizontally.
Enlarging

object

both

vertically

and

object

both

vertically

and

horizontally.
Enlarging
horizontally.
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1.Move the object
2.Enlarging

object

both

vertically

and

horizontally.

Table 2-1: Different mouse shapes and corresponding meanings

2.2.3 Shortcut keys
Table 2-2 below lists common shortcut keys. Designers can use these keys to quicken the
configuration.
Ctrl + C

Copy

Ctrl + V

Paste

Ctrl + X

Cut

Ctrl + left click

Select several objects at the same time.
Move the object chosen left, right, up and
down.

Esc

Cancel the command.

Del

Delete

Chapter 3 Basic steps of creating a project with
easyMonitor
3.1 Creating a new project with easyMonitor
To create a new project, click the “Project->new” command in File menu or the
“ Project->new” button in the tool bar, and then a pop-up dialog for new project creation will
appear. Select a directory for project saving, and choose a name for the project. Choose the
model of the touch screen corresponding to the project, click OK to complete the creation and
enter the communication port setting dialog. Click “Cancel” to quit the dialog.
3.1.1 New project dialog with easyMonitor
� Project name: The name of the project to be created.
� Path: Directory to save the new project file, C:\ in default.
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3.1.2 Create new device

When you create new project, there are 5 default devices can be used directly,
device, edit device or delete device by right click and select one operation.
You can click the “Device” and then right click.

You can select one existed device, and click right mouse.

Click Edit device, then the below dialog box will be appear.
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You can add

1.Name: The connection name edition, the default format is Com type:Port number: Address.
You can named the connection as your requirement.
2.Address: PLC address of ELC/EXM CPUs. Different connections must be different device
address.

You can change the CPU address by key pad Set..-> Set Adr -> Set M Adr
Also you can change the CPU address

by the programming software(xlogicsoft for xlogic,

eSmsConfig for x-Messenger). Menus in software is Tools-> Transfer -> set PLC’s address/Set
EXM address.

3. Protocol:

Modbus RTU and Modbus TCP are the optional

communication protocol.
4. Model: The CPU model will be monitored or controlled.
All the ELC series xLogic and EXM series CPU can be monitored. But some CPU have no
Ethernet connectivity, so those CPU will cannot be monitored via Ethernet connection, but the
serial connection is supported.
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5.Ext: Extension selection

Select how many extensions will be used by tick up the option box
6.Comm type :
There are 3 com type available:
RS232 : serial connection between PC and CPU.
RS485 : RS232 to RS485 converter needed, PLC shall be connected to the RS485 network.
Note: RS232 and RS485 in fact are both serial connection, you can select any one if use serial
port to communicate with PLCs.
You need set the serial port number and the BPS for serial connection, the default baud rates
of PLC is 9600. If you change the baud rates to 19200 or other option, you need change the
baud rates for COM1 of PLC first.

Ethernet/GPRS/WIFI:
This option is only applied to the CPUs which supports the ethernet connectivity.

MODE 1: easyMonitor directly connect to the Ethernet module(The Ethernet module must
work as server) without using the server software, here the IP address settings is the
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Ethernet module IP address, port is the local port in Ethernet module.

MODE 2: easyMonitor and devices(PLCs) are both connected to the server software. Now the
IP address settings is the IP of PC which installed server software, the port number also is
forward to the PC which installed the server software.

Domain name: This option is only for the EXM CPUs which supports the GPRS connection.
easyMonitor and the EXM are both can be connected to such domain name.(This domain
name need be forward to the PC which installed the server software).

3.1.3 Create the datas/variables/ for the devices

Click Edit device, then the below dialog box will be appear and then swith to the “Data” page.
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You can add new data, edit or delete the existed data by clicking the corresponding button.
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There are 9 kinds of data types:
Digital type includes : Input, Output, Flag, M;
Analog type includes: Analog input, Analog output, Analog flag, AM, Register

: You can select one as the start address.

: Enter into the count for the data, maximum 16 in one time.
If you want add one kind of data more than 16, you need add the data twice or more with
modify the start address.
For example, if you had added the flag as below figure shows, then the available flag would
be F1--F20 .

After the data had been added for a certain devices then confirm with ok button, then you
need add them in to the variable library, so, the data/ variable would be available for the
display objects.
Click the menu Variables -> Variable
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Two kinds variable are available : digital/analog variable from device or Global.
You can add new data, edit or delete the existed data by clicking the corresponding button.
Click “Add” to add the variable, then one variable will be added, then you can change the
variable type and variable name.

Double click each item to change what you need.
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Generally, we need select “Scan” for each variable. Upload is only for the application the GPRS
upload function block of EXM series CPU. We will describe it in detail at chapter 5.

Variable can be digital or analog type.

You can directly edit the variable name in the table.

3.2 Graph editing commands of easyMonitor
3.2.1 Combine and dispart of easyMonitor
“Combine” command is a group command, used to combine two or more graph objects in the
current screen to a whole graph object. The objects to be combined may be graphs drawn by
designers or users, or graphs from picture library of the system, or other controls such as
alarm control and trend chart. After combining the original properties of the graph elements
will not be kept. An combined object, graph or control is a whole image and can be saved as
library control for future use,helping to save much time of the users. “Dispart” command is
used to dispart a graph combined using “Combine”command to the original elements. After
disparting the original properties of the elements can be recovered.
“Dispart” command is a reverse command of “Combine” command.
The combining steps are as follows:
� First, choose the graph objects to be combined, then press “Combine” command by calling
the right click menu and choose combine command. Figure 4-6 shows the
contrast before and after combined.

Figure 4-6 shows the contrast before and after combined.
The disparting steps are as follows:
� Choose a graph object combined using combine command, and then choose dispart
command by calling the right click menu and choose Dispart command . Figure 4-7 shows the
contrast before and after disparting.
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Figure 4-7 shows the contrast before and after disparting.

3.2.2 Layout of easyMonitor

“Layout” command is a group command, used to adjust the display sequence of intersected
graph objects in the screen. Each graph in easyMonitor has a layer, and graph objects on
upper layer are always displayed on top of the objects on lower layer.
Thus, we can use this command to adjust layer level of graph objects. By default, objects
created later are on upper layer than those created earlier. There are four Layer commands
that are “Up”, “Down”, “To front”, and “To bottom”. To execute these commands, first
choose one or more graph objects in the current screen, and then choose corresponding
Layer commands in layout menu or by calling right click menu .
To front
This command is used to move the chosen object to the top layer of all the graph objects in
the current screen. Thus, the parts of other graphs intersected with this graph will be covered
by this graph. Figure 4-8 shows a contrast before and after such moving.

First choose an object in several graphs, and then choose Move to Top command in Layer
menu, or call the right click menu and choose To front command . See Figure 4-8 for a
comparison before and after combination.

Object before the forward

Object moved forward after

Figure 4-8: Contrast before and after moving object forward
To bottom
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This command is used to move the chosen object to the bottom layer of all the graph objects
in the current screen. Thus, the part of this graph intersected with other graphs will be
covered by other graphs. Figure 4-9 shows a contrast before and after such moving:
First choose an object in several graphs, and then choose to Bottom command in layout menu,
or call the right click menu and choose to Bottom command . See Figure 4-9 for a comparison
before and after combination.

Object before To bottom

Object moved To bottom

Figure 4-9: Contrast before and after moving object backward
Up
This command is used to move the chosen object to an upper layer over the graph object
intersected with it. Thus, the parts of other graphs intersected with this graph will be covered
by this graph. Figure 4-10 shows a contrast before and after such moving.
First choose an object in several graphs, and then choose Up command in layout menu, or call
the right click menu and choose Up command in the Layer option. See
Figure 4-10 for a comparison before and after combination.

Figure 4-10: Contrast before and after moving object one layer forward

Down
This command is used to move the chosen object to a lower layer than the graph object
intersected with it. Thus, the part of this graph intersected with other graphs will be covered
by other graphs. Figure 4-11 shows a contrast before and after such moving.

55

First choose an object in several graphs, and then choose Down command in Layout menu, or
call the right click menu and choose Down command. See Figure 4-11 for a comparison
before and after combination.

Object moved a layer of

The object of a back again

The object of a back twice

former
Figure 4-11: Contrast before and after moving object one layer backward

Left align
“Left Align” command allows designers to align several graph objects chosen basing on the
left boundaries of the graphs. To do this, first select several graph objects (2 or more), and
then click Left Align command in layout menu, or click Left Align button

in the tool

buttons. Then the graphs will move left to align basing on the left boundaries. See Figure 4-12
for a contrast before and after left align.

Left align before

Right align after
Figure 4-12: Contrast before and after left align

Right align
“Right Align”command allows designers to align several graph objects chosen basing on the
right boundaries of the graphs. To do this, first select several graph objects (2 or more), and
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then click Right Align command in layout menu, or click Right Align button

in the tool

buttons. Then the graphs will move right to align basing on the right boundaries. See Figure
4-13 for a contrast before and after right align.

Right align before

Right align after
Figure 4-13: Contrast before and after right align

Top Align
Top Align” command allows designers to align several graph objects chosen basing on the top
boundaries of the graphs. To this, first select several graph objects (2 or more), and then click
Top Align command in layout menu, or click Top Align button

in the tool buttons. Then

the graphs will move upward to align basing on the top boundaries. See Figure 4-14 for a
contrast before and after top align.

Top align before

Top align after
Figure 4-14: Contrast before and after right align

Bottom Align
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“Bottom Align”command allows designers to align several graph objects chosen basing on
the bottom boundaries of the graphs. To do this, first select several graph objects (2 or more),
and then click Bottom Align command in layout menu, or click Bottom Align button

in the

tool buttons. Then the graphs will move downward to align basing on the bottom boundaries.
See Figure 4-15 for a contrast before and after bottom align.

Bottom align before

Bottom align after

Figure 4-15 for a contrast before and after bottom align

Make same size
“Make same size” command allows designers to set the same height and width for several
graph objects chosen basing on the height and width of the highest graph object (considering
the top boundaries), with the top left coordinates of the graph objects being fixed. To do this,
first select several graph objects (2 or more), and then click Make same size in layout menu.
See Figure 4-16 for a contrast before and after such processing.

Make same size before

Make same size after

Figure 4-16: Contrast before and after “Make same size”
3.3 Drawing basic graphs with easyMonitor
This chapter introduces in detail the operations of drawing basic graphs with easyMonitor.
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3.3.1 Line of easyMonitor

:can be used to draw the straight line on any direction in the window.

Click Line

command button in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now
you can draw lines in the screen by clicking the mouse.


After completing the above steps, the line has default settings in line type, line width,
line color. You can modify these settings basing on actual needs. To do this, move the
mouse onto the line and double click, or click Properties button in the Edit menu after
choosing the line. At this moment, a property dialog as shown in Figure 4-17 will appear.

Figure 4-17: Line property dialog
The available settings include the Line color, line type, line width, other settings is not
available for the line/Tline object.
You may adjust the properties of the line using the pull-down and fine tuning button.
easyMonitor provides 5 line types,9 line widths.
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There are 5 types line available :
PS_SOLID:
PS_DASH:
PS_DOT:
PS_DASHDOT:
PS_DASHDOTDOT:

3.3.2 Rectangle of easyMonitor
Click Rectangle command button

in the tool buttons, and then move the

mouse to the picture editing window. At this moment the mouse shape will become a cross,
and now you can draw rectangle in the window.


To change the size of the rectangle, first choose it and move the mouse to any of the 8
green square dots on the frame of the rectangle. When the mouse becomes

, press

down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the rectangle has been adjusted.


After completing the above steps, the rectangle has default settings in transparency,
background color, fill type, fill color and the size. You can modify these settings basing on
actual needs. To do this, move the mouse onto the rectangle and double click, or click
Properties in the edit menu after choosing the rectangle. At this moment, a property
dialog as shown in Figure 4-18 will appear.
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Figure 4-18 Rectangle properties dialog

The available settings include the Foreground (is for the font color), background,Fill
type,Fill color and the size , other settings are not available for the “Rectangle” object.

Variable status/values can be displayed in such object if you select a variable(digital or analog
variable) in.
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You can input a static text or to show the register value with such text object.
A. As a static text display.

1.Input the static text in the variable box, and do not tick up the “as value” option.
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2. You can do not display the frame of the text without ticking up the “Display” option in
Frame, and set the color with select the color in foreground, and set the font with click the
“Select font” button.

3.3.3 Rounded rectangle of easyMonitor
Click Rounded Rectangle command button

in the tool buttons, and then move the mouse

to the picture editing window. At this moment the mouse shape will become a cross, and now
you can draw a rounded rectangle in the screen by clicking the mouse.


To change the size of the rectangle, first choose it and move the mouse to any of the 8
green square dots on the frame of the rectangle. When the mouse becomes

, press

down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the rectangle has been adjusted.


After completing the above steps, the rounded rectangle has default settings in
transparency, background color, fill type, fill color and the size. You can modify these
settings basing on actual needs. To do this, move the mouse onto the rectangle and
double click, or click Properties button in the tool bar after choosing the rectangle. At this
ment, a property dialog similar to that in rectangle drawing will appear. See Figure 4-19:

Figure 4-19 Rounded rectangle properties dialog
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The available settings include the Foreground (is for the font color),background,Fill type
and the size , other settings are not available for the “ Rounded Rectangle” object.

Variable status/values can be displayed in such object if you select a variable(digital or analog
variable) in.

The Displaying font also can be changed in the color option with the button “Select Font”.
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After the communication is established between easyMonitor and PLC, the digital status will
display 0/1(0= off, 1=on), the analog values of the selected register also will display the real
time values in the PLC

3.3.4 Ellipse/Circle of easyMonitor
Click Ellipse/Circle command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can draw ellipse/circle in the window.


To change the size of the ellipse/circle, first choose it and move the mouse to any of the
8 green square dots on the frame of the ellipse/circle. When the mouse becomes

,

press down the left key of the mouse and drag the mouse to an appropriate position.
Then release the left key of the mouse. So far the size of the ellipse/circle has been
adjusted.


After completing the above steps, the ellipse/circle has default settings in transparency,
background color, fill type, fill color and the size. You can modify these settings basing on
actual needs. To do this, move the mouse onto the ellipse/circle and double click, or click
Properties in the Edit menu after choosing the ellipse/circle. At this moment, a property
dialog similar to that in rectangle drawing will appear.See Figure 4-20.
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Figure 4-20 Ellipse/Circle properties dialog

The available settings include the Foreground (is for the font color), background,Fill
type,Fill color and the size , other settings are not available for the “Ellipse/Circle” object.
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Variable status/values can be displayed in such object if you select a variable(digital or analog
variable) in.

The Displaying font also can be changed in the color option with the button “Select Font”.

After the communication is established between easyMonitor and PLC, the digital status will
display 0/1(0= off, 1=on), the analog values of the selected register also will display the real
time values in the PLC

3.3.5 Cylinder of easyMonitor
Click Cylinder command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can draw cylinder in the window.


To change the size of the Cylinder, first choose it and move the mouse to any of the 8
green square dots on the frame of the Cylinder. When the mouse becomes

, press

down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the Cylinder has been adjusted.


After completing the above steps, the Cylinder has default settings in transparency,
Internal ellipse share, background color, fill type, fill color and the size. You can modify
these settings basing on actual needs. To do this, move the mouse onto the Cylinder
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and double click, or click Properties in the Edit menu after choosing the Cylinder . At this
moment, a property dialog similar to that in rectangle drawing will appear.See Figure
4-21.

Figure 4-21 Cylinder properties dialog’

Variable status/values can be displayed in such object if you select a variable(digital or analog
variable) in.

68

The Displaying font also can be changed in the color option with the button “Select Font”.

After the communication is established between easyMonitor and PLC, the digital status will
display 0/1(0= off, 1=on), the analog values of the selected register also will display the real
time values in the PLC

3.3.6 Pie chart of easyMonitor

Click Pie Chart command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can draw a pie chart in the screen by clicking the mouse. See Figure 4-22:

Figure 4-22: Draw a pie
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Move the mouse to any of the green dots in the rectangle, and at this moment the
mouse shape will become

. Then, you can change the span of the sector by moving

the mouse along an arc course.


After completing the above steps, the Pie Chart has default settings in background color,
fill type, fill color and the size. You can modify these settings basing on actual needs. To
do this, move the mouse onto the Fan Chart and double click, or click Properties in the
Edit menu after choosing the pie chart. At this moment, a property dialog similar to that
in rectangle drawing will appear.

3.3.7 Trapezia chart of easyMonitor

Click Trapezia Chart command button

in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now
you can draw a Trapezia chart in the screen by clicking the mouse. See Figure 4-23:



Move the mouse to any of the green dots in the rectangle, and at this moment the
mouse shape will become

. Then, you can change the span of the sector by moving

the mouse to an appropriate position.
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After completing the above steps, the Trapezia Chart has default settings in background
color, fill type, fill color and the size. You can modify these settings basing on actual
needs. To do this, move the mouse onto the Trapezia Chart and double click, or click
Properties in the Edit menu after choosing the Trapezia chart. At this moment, a property
dialog similar to that in rectangle drawing will appear.

3.3.8 Arrow of easyMonitor

Click Arrow Chart command button
in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you
can draw a Arrow in the screen by clicking the mouse. See Figure 4-24:

Figure 4-24 Arrow direction can be set in the property dialog box
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Move the mouse to any of the green dots in the rectangle, and at this moment the
mouse shape will become

. Then, you can change the arrow by moving the mouse to

an appropriate position.


After completing the above steps, the arrow has default settings in background color, fill
type, fill color and the size. You can modify these settings basing on actual needs. To do
this, move the mouse onto the arrow and double click, or click Properties in the Edit
menu after choosing the arrow. At this moment, a property dialog similar to that in
rectangle drawing will appear.

3.3.9 Multiple Text graphs of easyMonitor

Click Multiple Text command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can draw a text chart in the screen by clicking the mouse.

You can edit the static text or insert the register value with the format “@register name” .

72

The color can be changed with the foreground color, and

“select font” to change the text

font.

After the communication is established, then the register value will displayed followed the
symbol “@”.
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3.3.10 Data input of easyMonitor
Click data input command button
in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you
can draw a data input object in the screen by clicking the mouse.

Click the “Set” button in the property dialog box, then select one variable from the database,
then confirm with ok.
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The number color and Font can be set in the color option, then confirm with “ok”.
Under the monitoring mode, you only need to click the area of the data input object, then the
below dialog box would be pop out. Input the data required, and confirm with ok button.

Then the value will be set to the device(CPU).
Only the AF, AQ, and REG value can be set with such object, and please note if you want to set
the AF,AQ value, please do not connect the input leg of the AF,AQ block to other blocks in your
PLC program.
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As above figure showing, AF1--AF4 can not be set value, but the AF5--AF7 value can be set by
such data input object.

3.3.11 Table of easyMonitor
Click Line arrow command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can draw a Line arrow in the screen by clicking the mouse.



Move the mouse to any of the green dots in the rectangle, and at this moment the
mouse shape will become

. Then, you can change the table size by moving the

mouse to an appropriate position.


After completing the above steps, the table has default settings in the row count ,
columns count , line color, line width and the display size. You can modify these settings
basing on actual needs. To do this, move the mouse onto the table and double click, or
click Properties in the Edit menu after choosing the table. At this moment, a property
dialog similar to that in rectangle drawing will appear.

Rows count and columns count can be set in the property dialog box.
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The line of table can be set color width, and the table size also can be set with a fixed value.

3.3.12 Bitmap of easyMonitor

Click bitmap command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can put a bitmap in the screen by clicking the mouse.
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You can modify the basing on actual needs. To do this, move the mouse onto the bitmap
and double click, or click Properties in the Edit menu after choosing the bitmap. At this
moment, a property dialog similar to that in rectangle drawing will appear.

Click the button(marked with red circle in above figure) to insert a new bitmap.

Note: The bitmap must be imported from the “Bitmap” file in the boot folder of easyMonitor.,
so you need copy your own bitmap into such file first.


After the new bitmap imported in, you can move the mouse to any of the green dots in
the rectangle, and at this moment the mouse shape will become

. Then, you can

change the bitmap size by moving the mouse to an appropriate position.
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You can also select the dynamic image, when the condition (for example flag1 ==1), then the
“farrow.bmp” will display.
Note: 1.. flag1 is a digital register in the variable database.
2. You do not need select any register in the variable option.

3.3.13 Rotate Bitmap of easyMonitor

Click rotate bitmap command button

in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now
you can put a rotate bitmap in the screen by clicking the mouse.



You can modify the basing on actual needs. To do this, move the mouse onto the rotate
bitmap and double click, or click Properties in the Edit menu after choosing the rotate
bitmap. At this moment, a property dialog similar to that in rectangle drawing will
appear.
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Click the button(marked with red circle in above figure) to insert a new bitmap.

Note: The bitmap must be imported from the “Bitmap” file in the boot folder of easyMonitor.,
so you need copy your own bitmap into such file first.


After the new Rotate bitmap imported in, you can move the mouse to any of the green
dots in the rectangle, and at this moment the mouse shape will become

. Then, you

can change the Rotate bitmap size by moving the mouse to an appropriate position.

You can rotate the bitmap with set the angle in the red circled region in the property dialog
box.

3.3.14 gif picture of easyMonitor
Click gif picture command button
in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you
can put a gif picture in the screen by clicking the mouse.
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You can modify the basing on actual needs. To do this, move the mouse onto the gif
picture and double click, or click Properties in the Edit menu after choosing the gif picture.
At this moment, a property dialog similar to that in rectangle drawing will appear.

Click the button(marked with red circle in above figure) to insert a new gif picture.

Note: The gif picture must be imported from the “Bitmap” file in the boot folder of easyMonitor,
so you need copy your own gif picture into such file first.


After the new gif picture imported in, you can move the mouse to any of the green dots
in the rectangle, and at this moment the mouse shape will become

. Then, you can

change the gif picture size by moving the mouse to an appropriate position.

Click the “Variable” option to select a digital variable for controlling this gif picture
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If the variable is not equal to 0(both digital and analog variable), then the gif will be played
with an animation

3.3.15 3D circle of easyMonitor
Click 3D circle command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can put a 3D circle in the screen by clicking the mouse.



You can modify the basing on actual needs. To do this, move the mouse onto the 3D
circle and double click, or click Properties in the Edit menu after choosing the 3D circle
picture. At this moment, a property dialog similar to that in rectangle drawing will
appear.



After the 3D circle put in, you can move the mouse to any of the green dots in the
rectangle, and at this moment the mouse shape will become

. Then, you can change

the 3D circle size by moving the mouse to an appropriate position.
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Select a digital variable for this 3D circle. Then set the ON color and OFF color for it in the
Color option.

ON color and OFF color can be set by click the color area.

After the communication is established successfully, the corresponding color will be
displayed based on the digital register status.
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3.3.16 Button object of easyMonitor
Click button command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can put a button object in the screen by clicking the mouse.



You can modify the basing on actual needs. To do this, move the mouse onto the button
object and double click, or click Properties in the Edit menu after choosing the button
object. At this moment, a property dialog similar to that in rectangle drawing will appear.

You can input a static text on the center of the button object. (Do not tick up the “as
value” option). Or you also can select a variable with ticking up the “as value” option, then the
digital status will be display on the button.

The button color can be changed in the Background; the text color can be changed in the
Foreground, and the text font also can be changed with clicking the “Select Font”.
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After the button put in the window, you can move the mouse to any of the green dots in
the rectangle, and at this moment the mouse shape will become

. Then, you can

change the button size by moving the mouse to an appropriate position.

3.3.17 Databox of easyMonitor
Click Databox command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can put a databox object in the screen by clicking the mouse.



To change the size of the databox, first choose it and move the mouse to any of the 8
green square dots on the frame of the Cylinder. When the mouse becomes

, press

down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the Cylinder has been adjusted.


After completing the above steps, the databox has default settings foreground color(text
color), background color and the size. You can modify these settings basing on actual
needs. To do this, move the mouse onto the Databox and double click, or click Properties
in the Edit menu after choosing the database . At this moment, a property dialog similar
to that in rectangle drawing will appear.
85

Display decimal numbers can be set in the property dialog box.

The variable can be selected from the variable library in variable option
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The Size, background color, text color(foreground) and the text font can be changed in the
color option of the property box.

3.3.18 Date and time of easyMonitor

Click Date and time command button

in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now
you can put a Date and time object in the screen by clicking the mouse.



To change the size of the Date and time object , first choose it and move the mouse to
any of the 8 green square dots on the frame of the Date and time object. When the
mouse becomes

, press down the left key of the mouse and drag the mouse to an

appropriate position. Then release the left key of the mouse. So far the size of the Date
and time object has been adjusted.


After completing the above steps, the Date and time object has default settings
foreground color(text color), background color and the size. You can modify these
settings basing on actual needs. To do this, move the mouse onto the Date and time
object and double click, or click Properties in the Edit menu after choosing the data and
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time object . At this moment, a property dialog similar to that in rectangle drawing will
appear.

There are 4 types date and time display format.

The background color, foreground color(text color) and the text font can be changed in
the dialog box as above figure showing.
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3.3.19 Report table of easyMonitor

Click report command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can put a report object in the screen by clicking the mouse.



To change the size of the report table object , first choose it and move the mouse to any
of the 8 green square dots on the frame of the report object. When the mouse
becomes

, press down the left key of the mouse and drag the mouse to an appropriate

position. Then release the left key of the mouse. So far the size of the report object has
been adjusted.


After completing the above steps, the report object has default settings foreground
color(text color), background color, the size and the set the variable settings. You can
modify these settings basing on actual needs.
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To do this, move the mouse onto the report object and double click, or click Properties in
the Edit menu after choosing the report object . At this moment, a property dialog similar
to that in rectangle drawing will appear.

In the “Property”item, there are three options can be select for the report table.
A. Realtime data saved to database
If such option was selected, then the report table will display latest cycle data in realtime.

B. Daily report forms
If such option was selected, then the report table will display latest 24 hours data per hour.
C. Monthly report forms
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If such option was selected, then the report table will display latest month data per day.

Variable selection and caption edition can be done in the Data option of the property box.
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In color option, you can set the text color, background color, frame line width, type and color,
and the text font.

3.2.20 Trend chart of easyMonitor

Click trend chart command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can put a Trend chart in the screen by clicking the mouse.

Overview of trend chart:
Displaying continuous values of variables on a dynamic and continuous basis.
Reference curves for multiple data can be drawn. Time will be used as the horizontal axis and
value will be used as the vertical axis to visualize the change trend of the value in a period.
3 polygonal lines can be displayed at most (line chart).

92

Related variable: you can select the variable for the Curve1, Curve2, Curve3.
Curve colour: you can set the colors for the curve1, curve2,curve3 separately.
Scale: You can set the Upper limit and the lower limit of the Y axis.
Show flag: Show or Hide the name of the Curves.

Foreground : Used to set the text color.
Background: To set the background color of the trend chart.
Select Font: To set the text Font.
Size: To set the size of the trend chart.
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3.2.21 History trend chart of easyMonitor

Click History trend chart command button
in the tool buttons, and then move the
mouse to the picture editing window. At this moment the mouse shape will become a cross,
and now you can put a history Trend chart in the screen by clicking the mouse.

3.2.22 Bar of easyMonitor

Click bar chart command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can put a bar chart in the screen by clicking the mouse.
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To change the size of the bar object , first choose it and move the mouse to any of the 8
green square dots on the frame of the bar object. When the mouse becomes

, press

down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the bar object has been adjusted.


After completing the above steps, the bar object has default settings foreground
color(text color), background color and the size. You can modify these settings basing on
actual needs. To do this, move the mouse onto the bar object and double click, or click
Properties in the Edit menu after choosing the bar object . At this moment, a property
dialog similar to that in rectangle drawing will appear.

Related variable: you can select the variable for the Bar1, Bar2, Bar3.
Bar colour: you can set the colors for the bar1, bar2,bar3 separately.
Scale: You can set the Upper limit and the lower limit of the Y axis.
Show flag: Show or Hide the name of the Bars.
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3.2.23 Single Bar of easyMonitor

Click single bar chart command button

in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now
you can put a single bar chart in the screen by clicking the mouse.



To change the size of the single bar object , first choose it and move the mouse to any of
the 8 green square dots on the frame of the single bar object. When the mouse
becomes

, press down the left key of the mouse and drag the mouse to an appropriate

position. Then release the left key of the mouse. So far the size of the single bar object
has been adjusted.


After completing the above steps, the single bar object has default settings foreground
color(text color), background color and the size. You can modify these settings basing on
actual needs. To do this, move the mouse onto the bar object and double click, or click
Properties in the Edit menu after choosing the bar object . At this moment, a property
dialog similar to that in rectangle drawing will appear.

Range : You can set the Upper limit and the lower limit of the Y axis.
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Variable: Select a variable for the signal bar from the variable library.

You can change the foreground, background color and size for the signal bar.

3.2.24 Meter of easyMonitor

Click Meter command button

or

in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now
you can put a meter chart in the screen by clicking the mouse.
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To change the size of the Meter object , first choose it and move the mouse to any of the
8 green square dots on the frame of the Meter object. When the mouse becomes

,

press down the left key of the mouse and drag the mouse to an appropriate position.
Then release the left key of the mouse. So far the size of the meter object has been
adjusted.


After completing the above steps, the meter object has default settings foreground
color(text color), background color and the size. You can modify these settings basing on
actual needs. To do this, move the mouse onto the meter object and double click, or click
Properties in the Edit menu after choosing the meter object . At this moment, a property
dialog similar to that in rectangle drawing will appear.

Range: Range set, you can set the Min and Max value.
Scale Decimals: Decimals set for scale value.
Value Decimals: Decimals set for the real time value.
Scale Number: You can set the numbers of scales here.
Caption&Unit: You can set the caption and the unit for the actual signals.

Variable selection for the meter displaying.
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You can change the background, Foreground(text color), Text font and the size in the color
option.

3.3.25 Breaker of easyMonitor

Click breaker command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can put break chart in the screen by clicking the mouse.

The background can be changed in the color option of the property dialog box.
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3.3.26 Switch symbol of easyMonitor

Click switch symbol command button

in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now
you can put switch symbol in the screen by clicking the mouse.

The line width can be changed in the property dialog box.

3.3.27 Transfer symbol of easyMonitor

Click transfer symbol command button

in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now
you can put transfer symbol in the screen by clicking the mouse.

3.3.28 Fan of easyMonitor

Click fan command button

in the tool buttons, and then move the mouse to the picture

editing window. At this moment the mouse shape will become a cross, and now you can put
fan in the screen by clicking the mouse.
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To change the size of the Fan object , first choose it and move the mouse to any of the 8
green square dots on the frame of the Fan object. When the mouse becomes

, press

down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the fan object has been adjusted.


After completing the above steps, the fan object has default settings foreground
color(text color), background color and the size. You can modify these settings basing on
actual needs. To do this, move the mouse onto the fan object and double click, or click
Properties in the Edit menu after choosing the fan object . At this moment, a property
dialog similar to that in rectangle drawing will appear.

3.3.29 Button switch of easyMonitor

Click button switch command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can put

button switch in the screen by clicking the mouse.
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OFF:


ON:

To change the size of the button switch object , first choose it and move the mouse to any
of the 8 green square dots on the frame of the button switch object. When the mouse
becomes

, press down the left key of the mouse and drag the mouse to an appropriate

position. Then release the left key of the mouse. So far the size of the button switch
object has been adjusted.


To change the property of the button switch, move the mouse onto the button switch
object and double click, or click Properties in the Edit menu after choosing the button
switch object . At this moment, a property dialog similar to that in rectangle drawing will
appear.

You can select the default type switch, or Insert your picture with the “User define”
option.

Set the action, then select a variable which need be controlled.
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Select a variable for the status monitoring, it does not must be the same as the variable
in the action option.

3.3.30 Valve of easyMonitor

Click valve command button
in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you
can put

valve in the screen by clicking the mouse.
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To change the size of the valve object , first choose it and move the mouse to any of the
8 green square dots on the frame of the valve object. When the mouse becomes

,

press down the left key of the mouse and drag the mouse to an appropriate position.
Then release the left key of the mouse. So far the size of the valve object has been
adjusted.

3.3.31 Slider shape of easyMonitor
Click slider command button

in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can put slider in the screen by clicking the mouse.



To change the size of the slider object , first choose it and move the mouse to any of the
8 green square dots on the frame of the slider object. When the mouse becomes

,

press down the left key of the mouse and drag the mouse to an appropriate position.
Then release the left key of the mouse. So far the size of the slider object has been
adjusted.
、
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3.3.32 Pipe of easyMonitor

Click one kind of pipe command button

in the tool buttons,

and then move the mouse to the picture editing window. At this moment the mouse shape will
become a cross, and now you can put one kind of pipe in the screen by clicking the mouse.

Pipe:

Connect pipe:

Bend pipe:

Free pipe:

Tank:

Elbow pipe:
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Rod:

Rect pipe:

Free trapezoid:
Standard trapezoid:

Ellipse pipe:



To change the size of the pipe object , first choose it and move the mouse to any of the
8 green square dots on the frame of the pipe object. When the mouse becomes

, press

down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the pipe object has been adjusted.

3.3.33 Data input

Click “data input” button

in the tool buttons, and then move the mouse to the picture

editing window. At this moment the mouse shape will become a cross, and now you can put
object in the screen by clicking the mouse.

Double click to choose the variable for the data input object.
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AF and REG value can be set with this data input object. But the AF input leg must be no
connection.
For example:

In above program,AF1 and AF2 value can be changed with the data input object. AF3 value
cannot be changed, because there is a connection on its input leg.

You can input the value which shall be set into PLC.
3.3.34 Logic function bitmap switch

Click “logic function bitmap switch” button

in the tool buttons, and then move the mouse

to the picture editing window. At this moment the mouse shape will become a cross, and now
you can put the object in the screen by clicking the mouse.
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To change the size of the bitmap object , first choose it and move the mouse to any of the
8 green square dots on the frame of the bitmap object. When the mouse becomes

,

press down the left key of the mouse and drag the mouse to an appropriate position.
Then release the left key of the mouse. So far the size of the bitmap object has been
adjusted.
Double click the bitmap to enter into the property dialog box.

Double click the rows to edit the condition and corresponding picture. There are total 50
Pictures can be changed with different condition. And the big index number has priority than
the small one.
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After, the logic edited, you can choose a picture for this condition, or keep it Null if no picture
to be displayed when this condition is true.

For example, you can realize this function with such object like this,
F1=1, Display picture 1
F2=1, Display picture 2
F3=1, Display picture 3
F4=1, Display picture 4
F5=1, Display picture 5
Q1=1, Display picture 6.....
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3.3.35 Instant on button
Click “Instant on” button
in the tool buttons, and then move the mouse to the picture
editing window. At this moment the mouse shape will become a cross, and now you can put
the object in the screen by clicking the mouse.



To change the size of the Instant on button object , first choose it and move the mouse
to any of the 8 green square dots on the frame of the Instant on button object. When the
mouse becomes

, press down the left key of the mouse and drag the mouse to an

appropriate position. Then release the left key of the mouse. So far the size of the
Instant on button object has been adjusted.
Double click the Instant on button to enter into the property dialog box.

This button always keep HI status, if you press down the button, then it will be switch to Low
status, but after you release the button, it will switched to HI status again.

3.3.36 Flow

Click “flow” button

in the tool buttons, and then move the mouse to the picture editing

window. At this moment the mouse shape will become a cross, and now you can put the
object in the screen by clicking the mouse.
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You can change the color and width of the flow in color table. And in logic table, you can set
the logic for the flow forward and flow backward .
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3.3.37 Flat flow

Click “flat flow” button

in the tool buttons, and then move the mouse to the picture

editing window. At this moment the mouse shape will become a cross, and now you can put
the object in the screen by clicking the mouse.

The color of the frame line and flow line can be changed in color table of the dialog box.
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3.38 Modify block parameters
Click “modify block parameters” button
in the tool buttons, and then move the mouse to
the picture editing window. At this moment the mouse shape will become a cross, and now
you can put the object in the screen by clicking the mouse.

Caption: The default text is combined with the block number, block name and the selected
block parameter. You can modify it as well.
Device: you need select one device which created in the project device list.
Block type:The function block number in your PLC program. The available function block:

After the connection is established with the PLC, then you can click the object to modify the
corresponding block parameter.
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To click “get” button to read the value from the PLC.

To click “set” button to set the value to the PLC.

Chapter 4 Example showing
4.1 Create new device
Create a new project by click project -> new, then:
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There are 5 devices in default, here we delete 4 of 5, we only use one Device for
communication.

Here, we use a ELC-12DC-DA-R-N CPU and one extension(ELC12-E-8DC-DA-R), the
communication port is port 3, baud rates 9600.
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4.2 Create new data for the devices
Establish data in the data option:

Now we can add the variable in the variable value based on requirement, the example
program as below:
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We will create objects to monitor the below objects.
1.Digital inputs/outputs status, digital flag, M.

Note: the input leg of the output/digital flag block if did not be linking with other block, then
its status can be changed with a button in SCADA, In the

example program the Q013, Q014

can be controlled with SCADA.
2.Analog inputs , analog outputs,analog flags, and AM

,

,

Note: we can also set the AQ and AF value, in the SCADA if the input leg of the block(analog
output and analog flag) is not connecting with other blocks. In the example program, the
AF5,AF6,AF7 can be set value between “-32767” and “32767”
3.REG
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Note: The REG value can be read and also can be set, but it is the current value of the blocks,
for example, if you set a value to REG2, then the current count value of B003 will be changed,
but the on/off threshold and the start value cannot be directly changed via SCADA, but you
can use the “reference” function is the block.
As below:

If you want to change the ON/OFF threshold value via SCADA, then you need to change the
B002 value(REG1) for the On threshold, and change the B003 value(REG2) for the Off
Threshold.

4.3 Add the data into the variable database

We need add all the variables into the variable database via the menu “variable”.
Note: Only the data in the variable database will be read from the devices.

118

“ Batch add” : This button is used to add all the registers in to the variable database with
once operation.
“Add” : You only can add one variable once.
“Delete”: This is used to delete one variable once.
“Clear”: This button is to clear all the variables one.
You can double click the items to select the
“device”,”Scan/upload”,”digital/analog””Source/registers”, and input the variable name and
the default value for a certain register.

Note:
The “SCAN” means the easyMonitor sends data to PLC, and PLC do response.
The “Upload” is only for the GPRS data upload mode, so such mode is only for the EXM GPRS
connection, and EXM need use the “GPRS DATA upload” in the program and select the
“custom MODBUS”

4.4 Create widows as your requirement
Here we create serval windows for how to read and set the register value.

119

We can edit the viewer caption by right click.

IO status monitoring window

We can use “3D circle” object to display the status of the digital status, here we set as default
for the digital IOs. HI/ON = RED, LOW/OFF = GREEN.
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Select the relative variable and tick up the “as value” option

You can change the ON/OFF color as you need.

We can use a multiple text to directly the analog input values based on the fixed format with
@variable.

We can use a bar object to showing AI1--AI3 of CPU simultaneity
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We can use the button object to change the digital status.
Note: The input leg of digital flag or output block must be not connected with other blocks,
then the digital flag and output can be changed with the button object.
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Parameter setting window

Digital status settings
We can use the “button” object and the “button switch” object to change the digital status.
We can insert a gif object into the screen, then if the digital F4 is switched on, then the gif
picture will be played, so we can get a animation.
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Set AF value, you can click the area of the AF data input object under monitoring mode, then
one data input box will be pop up. After input the data, confirm with click “OK” button.

Note: The input leg of analog flag or output block must be not connected with other blocks,
then the digital flag and output can be changed with the button object.

Set REG value
you can click the area of the REG data input object under monitoring mode, then one data
input box will be pop up. After input the data, confirm with click “OK” button.
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The easyMonitor can read the variable value includes AM,AF,AI,AQ,REG. The “data reading”
window is using the “Rect” to read all the analog variable value.

125

You only need to select the variable from the variable database, and tick up the “as value”
option. Then the value will be read under the monitoring mode.

126

There are a default “Cureviewer” window to show some analog values.

Click the “Property” button, then you can select a variable and set the Max AND Min value.

Now you can startup monitoring the device.
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4.4 Monitoring with serial connection:
Hardware connection:

Device settings

After all the connection and the settings are ok, we only need to start the monitoring with
click the “start/stop”

button.
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You can add a digital flag(example is F1) in your program, then in the window, you will see the
status is turning on/off, otherwise the communication is failed.
Note: If there are multiple devices need be monitored, we must set them with separately
address, If there are 2 or more same address in the devices, the communication would be
work incorrect.

4.5 Monitoring with Ethernet/GPRS/WIFI connection
4.5.1 Device works as server
Hardware connection(this connection is only applied to Ethernet and WIFI, GPRS is not
available):

In this case, the easyserver does not need, easyMonitor can directly connect with the device
with Modbus TCP.
This connection are both applied to LAN and Internet, but we need a static IP address for the
device end if Internet connection is required. Here we take an example for the Internet
connection.
Example,now we have a static IP address here “221.226.289.74” connected to router, Then
we set the Ethernet CPU works as server, the IP address is 192.168.0.133 in the LAN, the
local port is 5001. So we need forward the 5001 port to the IP “192.168.0.133”.
129

Then our easyMonitor works in the Internet will be connected to the IP 221.226.189.74.

CPU address is 1
Protocol :MODBUS TCP
PORT:5001
IP address: 221.226.189.74(static IP address for the router which connected with Ethernet
CPU)
After all the connection and the settings are ok, we only need start the monitoring with click
the “start/stop”

button.
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You can add a digital flag(example is F1) in your program, then in the window, you will see the
status is turning on/off, otherwise the communication is failed.
Note: If there are multiple devices need be monitored, we must set them with separately
address, If there are 2 or more same address in the devices, the communication would be
work incorrect.

4.5.2

Device works as client

Hardware connection(this connection is applied to Ethernet ,WIFI and GPRS.GPRS function of
EXM only can be applied with such connection):

In this case, we need use the easyserver for transmitting the datas between easyMonitor and
devices.
This connection are both applied to LAN and Internet, but we need a static IP address for the
easyServer end if Internet connection is required. Here we take an example for the Internet
connection.
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Example,now we have a static IP address here “221.226.189.74” connected to router, Then
we set the my PC(installed the easyServer) IP address 192.168.0.133 in the LAN, then we
forward the 5001 port to the IP “192.168.0.133” in the router.
We also need forward another port number for the easyMonitor, here we have installed the
easyMonitor and easyServer on a same PC, so they are in local, we do not need forward the
port number for the easyMonitor anymore.

The default port number is 6365 for easyMonitor, 6364 for the device, so here, we need to
change the device port to 5001. Then the device would connect to the server 221.226.189.74
5001.

After the easyServer started, we can set the start way by right click
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There are 3 run types for the easyServer.
a. Run with system
b. Run with easyMonitor
c. Manual run
The device settings need be changed as below:

Start the server
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The device will be connected with this server, and you can view which one in the easyServer.
Now you can start the easyMonitor by click the “start”
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button.

You can click the button

to see the communication data between easyMonitor and the

devices.
When you communicate the EXM with easyMonitor, you also need set the easyServer as
above, then to set the IP address of the easyServer(Static IP address/domain name) and the
port number in the GPRS parameters

Notes: 1.The GPRS connection is wireless and the communication speed is also not too fast,
so it is not suitable for the communication speed requirement.
2. GPRS communication data will also take some cost for the SIM card provider.
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Chapter 5 How to use GPRS data Upload function
This chapter is used to describe how to use the “GPRS upload” function to transfer the data
from EXM to SCADA. And this chapter contents is only can be applied to the EXM series CPU.

We will make an example to show you how to configure in eSmsconfig and easySCADA.
In eSmsconfig, you can find a function block named “GPRS Data Upload”

You can configure the remote IP address(the static IP address of the easyServer) and the port
in the property dialog box of GPRS Data Upload. Then we need select “custom Modbus”
option ,then select the data shall be transferred to SCADA.
Note: In this example, the static IP address for the router connected with the PC with
easyServer is 221.226.189.74, then in the router we forward a port 5001 to the easyServer
PC(This PC IP address in LAN is 192.168.0.227).
Hence, in the GPRS data upload function block we set the remote IP address is
221.226.189.74 and the port is 5001..
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Then you can add a device in easyMonitor.
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The IP address is the PC IP address which installed easyserver(so the IP address might be the
local IP address 192.168.0.227, not the static one). The port is the same one in easyServer.

Click the “Auto upload” table to add the variables .
Note:
Add the variable here need be totally same as the configuration in the GPRS data upload
function block in eSmsconfig.
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Then you need add the variable into the variable library. All the variable for the GPRS unload
need be select “upload” in the variable table.
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Now, you can put objects in the monitor interface, and select variable for them.

Start the easySever, you can see the easyMonitor is available.
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If the GPRS Data Upload function block in the EXM is triggered, and the easyserver get the
datas from the EXM, then the picture of the EXM will be available as well.

Then the objects will display the corresponding status or value as follows:

Chapter 6 How to update a setup for end user?
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6.1 Compile the project and create a setup file
After you finished your project test and want to supply a version for end-user.
Step 1: Click the menu Project->Compile..

There is a .bin file will be created, click ok.
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In above dialog box, you can edit the setup name, version number and Publisher ID(This ID
will be used when getting register ID).
Click “Create”.
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This setup file will be supplied to the end-user.

Set 2: Create register ID for end-user.
When the end user install the setup and before the project opened, they will be asked to input
correct register ID.
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This Register code is create by the software included in the easySCADA.

You can click the “Register” button,

In the above “Register” dialog box, you need select the project name, then the publisher ID
will be pop out automatically, then you input the user machine code(the end user supply to
you). And Click the “Get” button.
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Now you can send the register code to the end user.

Step 3: The end user input the register code and click register button, then the project can be
opened.
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REVISION RECORD
Revision

Description

2014.5.8

3.3.19 Report table of easyMonitor report object is available now.

2014.12.23

Fan object is available!

2015.7.28

The projects can be compiled for end-users now, the description is added in
1.6.1 compile..
Data input object added in 3.3.33
Logic function bitmap switch added in 3.3.34
Instant on button object added in 3.3.35
Flow object added in 3.3.36
Flatflow object added in 3.3.37

147

Instant on button object added
GPRS upload function added in chapter 5.
2017.6.13

Chapter 6 How to export a setup for end user
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